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Management Tools in Cisco Unified 
MeetingPlace for Lotus Notes

This chapter includes the following sections:

• How to Access the Gateway System Integrity Manager Tab, page 3-1

• How to Change Unit Configuration from the Gateway SIM, page 3-2

• About the Notification Tab, page 3-5

• About the Notes Gateway Tab, page 3-6

• How to Update an Account from the Web Conferencing Tab, page 3-7

• How to Configure the Calendar Entry Form by Using the MeetingPlace Server Agent Database, page 
3-8

• How to Configure Cisco Unified MeetingPlace for Lotus Notes for Mixed Groupware 
Environments, page 3-13

• How to Monitor Performance, page 3-14

How to Access the Gateway System Integrity Manager Tab
The Gateway System Integrity Manager (SIM) improves the reliability and serviceability of Cisco 
Unified MeetingPlace Web Conferencing and other Cisco Unified MeetingPlace integrations, such as 
Cisco Unified MeetingPlace for Lotus Notes, by detecting outages, logging these errors to the 
MeetingPlace Alarm Table, and allowing a Cisco Unified MeetingPlace support representative to 
remotely administer and diagnose your Cisco Unified MeetingPlace integration systems.

The Gateway SIM is located in the MeetingPlace Gateway Configurations utility. The Gateway SIM 
Manager resides on the Cisco Unified MeetingPlace Audio Server system. If the Gateway SIM Manager 
does not receive these updates when expected, it logs a major alarm to the MeetingPlace Alarm Table.

The bottom left pane of the Gateway SIM tab shows the hostname of the Cisco Unified MeetingPlace 
Audio Server system to which the integration server is currently connected. The bottom right pane shows 
whether the integration server is connected to the indicated Audio Server system or not (Connected or 
Disconnected), the assigned unit number and IP address of the integration server, and the version of the 
Cisco Unified MeetingPlace Audio Server system.
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Note You should configure the Gateway SIM when you install Cisco Unified MeetingPlace Web 
Conferencing. For a description of each parameter, see the applicable Administration Guide for Cisco 
Unified MeetingPlace Web Conferencing, at 
http://cisco.com/en/US/products/sw/ps5664/ps5669/products_installation_and_configuration_guides_l
ist.html.

Accessing the Gateway SIM
To Access the Gateway SIM

Step 1 Double-click the Cisco Unified MeetingPlace icon located in the system tray. The MeetingPlace 
Gateway Configurations utility appears.

Step 2 Click the Gateway SIM tab.

How to Change Unit Configuration from the Gateway SIM
If you need to change the Cisco Unified MeetingPlace Audio Server system to which the integration 
server is connected, you can do so from the Gateway SIM tab. To change the unit configuration, 
complete the following tasks:

.

Task Reference
Step 1 Stop all Cisco Unified 

MeetingPlace services and IIS.

Note Do not restart services 
until the end of this 
procedure.

See the “Stopping and Restarting Cisco Unified MeetingPlace 
Web Conferencing Services” section on page 3-3.

Step 2 Delete the connection to the 
current Audio Server system. 

See the “Deleting the Connection to a Current Cisco Unified 
MeetingPlace Audio Server System” section on page 3-3.

Step 3 Change the Audio Server 
hostname from the old server 
name to the new server name in 
the MPWEB database.

See the “Changing the Audio Server Name in the MPWEB 
Database” section on page 3-4.

Step 4 Add the new Audio Server system. See the “Adding a New Cisco Unified MeetingPlace Audio 
Server System” section on page 3-4.

Step 5 Complete the change unit 
configuration procedure.

See the “Completing the Change Unit Configuration” section on 
page 3-5.
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Stopping and Restarting Cisco Unified MeetingPlace Web Conferencing 
Services

Cisco Unified MeetingPlace for Lotus Notes requires that you stop all Cisco Unified MeetingPlace Web 
Conferencing services before performing certain procedures, including MeetingPlace Gateway SIM 
upgrades and configuration changes.

To Stop or Restart Cisco Unified MeetingPlace Web Conferencing Services

Step 1 From the Windows Start menu, choose Settings > Control Panel > Administrative Tools > Services.

Step 2 Do the following, as applicable:

• For all Cisco Unified MeetingPlace Web Conferencing services, right-click Cisco Unified 
MeetingPlace Web Conferencing and choose Stop.

• For other Cisco Unified MeetingPlace integration services (if required), including MeetingPlace 
Gateway SIM, right-click the service and choose Stop.

• If the IIS Admin Service is still running, right-click the service and choose Stop.

Step 3 Close the Services control panel.

Step 4 To restart services after you have completed your upgrade or procedure, open the Services control panel.

Step 5 Right-click Cisco Unified MeetingPlace Web Conferencing and choose Start. If you stopped any other 
integration services, restart them by right-clicking the appropriate service and choosing Start.

Step 6 When you finish, close the Services control panel.

Deleting the Connection to a Current Cisco Unified MeetingPlace Audio 
Server System

Make sure that you have detached the integration server from the primary Cisco Unified MeetingPlace 
Audio Server system database by stopping the Cisco Unified MeetingPlace services and IIS.

To Delete the Connection to a Cisco Unified MeetingPlace Audio Server System

Step 1 From your system taskbar, right-click the Cisco Unified MeetingPlace icon and choose Properties. The 
MeetingPlace Gateway Configurations utility appears.

Step 2 From the list on the left, click the name of the Cisco Unified MeetingPlace Audio Server system that you 
want to disconnect from, then click Delete. This deletes this integration server—otherwise referred to 
as a “unit”—from the primary Cisco Unified MeetingPlace Audio Server system.

Step 3 Continue with the “Changing the Audio Server Name in the MPWEB Database” section on page 3-4.
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Changing the Audio Server Name in the MPWEB Database
The integration server is configured to point to a particular Cisco Unified MeetingPlace Audio Server 
system. To update the Audio Server system that this integration server points to, you will need modify 
the Audio Server name in the database.

To Delete the Master and Slave Databases

Step 1 Open Enterprise Manager and navigate to the \Databases folder.

Step 2 Choose and expand the MPWEB database.

Step 3 From the left pane, choose Tables.

Step 4 In the right pane right-click System, then from the pop-up menu, choose Open Table > Return All 
Rows.

Step 5 Change the value in the HostName column to the desired value.

Step 6 Continue with the “Adding a New Cisco Unified MeetingPlace Audio Server System” section on 
page 3-4.

Adding a New Cisco Unified MeetingPlace Audio Server System
To Add a New Cisco Unified MeetingPlace Audio Server System

Step 1 Open the Gateway SIM tab.

a. From your system taskbar, right-click the Cisco Unified MeetingPlace icon and choose Properties. 
The MeetingPlace Gateway Configurations utility appears.

b. Click the Gateway SIM tab.

Step 2 Click Add. The Cisco Unified MeetingPlace Server Entry window appears.

Step 3 In the Cisco Unified MeetingPlace Server Entry window, enter the new configuration information as 
shown in the following table.

For Do This

Server Name Enter the hostname of the Cisco Unified MeetingPlace Audio Server system.

Shadow Server Leave this field as is.

Client IP Address Enter the IP address of the server on which the Gateway SIM is installed.

Transfer Destination Leave this field as is.

Link Encryption 
Disabled

Leave this check box unchecked to encrypt communications between the 
Gateway SIM and the Cisco Unified MeetingPlace Audio Server system.

Encryption uses a 56-bit DES algorithm with a secret key.

Note You can check this option to send communications in clear text; 
however, we do not recommend this.
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Step 4 Click OK, then OK again to complete adding this unit to the entered Cisco Unified MeetingPlace Audio 
Server system.

Step 5 Continue with the “Completing the Change Unit Configuration” section on page 3-5.

Completing the Change Unit Configuration
To Complete the Change Unit Configuration

Step 1 From the Windows Services control panel, restart the services you stopped in Step 2 of the “To Stop or 
Restart Cisco Unified MeetingPlace Web Conferencing Services” procedure on page 3-3 by 
right-clicking each service and choosing Start.

Step 2 From the Gateway SIM tab, verify that the integration server is attached to the new Cisco Unified 
MeetingPlace Audio Server system and that a unit number is assigned. The newly entered Audio Server 
system is listed in the left window.

Step 3 Verify the connection to the Audio Server system and the unit number by telnetting to the Audio Server 
system, as follows:

a. Telnet <Cisco Unified MeetingPlace Audio Server name>

b. Log in, then enter gwstatus. The name of your Cisco Unified MeetingPlace integration displays.

Step 4 Update the Web Conferencing server with user and meeting information from the new Audio Server 
system:

a. Sign in to Cisco Unified MeetingPlace Web Conferencing.

b. From the Welcome page, click Admin, then click Replication Service.

c. For Replication Service Command, choose Update All User Profiles.

d. Click Submit.

e. Change the Replication Service Command to Update All Meetings.

f. Click Submit.

About the Notification Tab
The Notification tab allows you to configure the hostnames of the Cisco Unified MeetingPlace Web 
Conferencing servers that are required for Cisco Unified MeetingPlace notification. Table 3-1 provides 
descriptions of the Notification tab fields.

Table 3-1 Notification Tab Fields

Field Description

Version The Cisco Unified MeetingPlace Notification Gateway release number.
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About the Notes Gateway Tab
The Notes Gateway tab allows you to change some of the settings that were configured during the Cisco 
Unified MeetingPlace for Lotus Notes installation, such as the MeetingPlace mailbox, the polling 
frequency, and Domino polling frequency. Table 3-2 provides descriptions of the Notes Gateway tab 
fields.

Web Hostname The primary fully qualified domain name (FQDN), hostname, or IP 
address of the Cisco Unified MeetingPlace Web Conferencing server 
used for internal meetings. (This is configured as the Hostname [Home 
Page] on the Web Conferencing server.)

External Web Hostname The primary FQDN, hostname, or IP address of the Web Conferencing 
server used for external meetings. If left blank, notifications default to 
the Web Conferencing server indicated for Web Hostname. (This is 
configured as the Hostname [Home Page] on the Web Conferencing 
server.)

Attach Links as URL This option applies only to Cisco Unified MeetingPlace for Outlook and 
SMTP integrations.

Verbose Logging Allows more detail in entries logged to the Gateway SIM log.

Table 3-1 Notification Tab Fields (continued)

Field Description

Table 3-2 Notes Gateway Tab Fields

Field Description

Version The Cisco Unified MeetingPlace for Lotus Notes release number.

Domino Server The hostname of the Domino server that Cisco Unified MeetingPlace for 
Lotus Notes is connected to.

notes.ini Path The location of the notes.ini file for the Cisco Unified MeetingPlace for 
Lotus Notes account.

Notes Password The password for the Cisco Unified MeetingPlace for Lotus Notes account 
on the Domino server.

MeetingPlace Mailbox The MeetingPlace mailbox used by Cisco Unified MeetingPlace for Lotus 
Notes to pick up notifications for meetings scheduled from MeetingTime 
or Cisco Unified MeetingPlace Web Conferencing. You must change this 
mailbox if Cisco Unified MeetingPlace for Outlook also points to the same 
Cisco Unified MeetingPlace Audio Server system. For more information 
about configuring the MeetingPlace mailbox, see the “Enabling Cisco 
Unified MeetingPlace Mailbox Automated Maintenance” section on 
page 3-12.

Polling Frequency How often Cisco Unified MeetingPlace for Lotus Notes polls the Cisco 
Unified MeetingPlace Audio Server system for new notifications (in 
milliseconds).
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How to Update an Account from the Web Conferencing Tab
The Web Conferencing tab allows you to change the username and password that is used to access the 
MPWEB database. This tool updates the integration server to pick up the change you already made in 
SQL Server; it does not make the change for you in SQL Server. Make sure that you have already 
changed the username and password on the SQL Server before accessing this tool.

Note You cannot use the Web Conferencing tab to configure a least privileged SQL account. For instructions 
on creating a least privileged SQL account, see the MeetingPlace Web SQL Account Requirements for 
Database Access Authentication tech note at 
http://www.cisco.com/en/US/products/sw/ps5664/ps5669/products_tech_note09186a00802262e5.shtm
l.

To Update an Account from the Web Conferencing Tab

Step 1 Stop the Cisco Unified MeetingPlace Web Conferencing Service as described in the “Stopping and 
Restarting Cisco Unified MeetingPlace Web Conferencing Services” section on page 3-3.

Step 2 From your system tray, double-click the Cisco Unified MeetingPlace icon. The MeetingPlace Gateway 
Configurations utility appears.

Step 3 Click the Web Conferencing tab.

Step 4 For Server, enter the hostname or IP address of the SQL Server you updated. For a local server, enter 
local.

Domino Polling 
Frequency

How often Cisco Unified MeetingPlace for Lotus Notes polls the Domino 
server for any new meetings scheduled from Lotus Notes with attachments.

If such meetings exist, these attachments are uploaded to the Cisco Unified 
MeetingPlace Audio Server system through the Cisco Unified 
MeetingPlace Agent Service.

The default value for this parameter is 120000 milliseconds (2 minutes). 
Setting this parameter to 0 turns the replication off.

Domino polling frequency requires a web hostname value for the location 
of the Cisco Unified MeetingPlace Agent Service. If the web hostname 
field in the Notification tab is blank, it will default to “localhost.”

Authentication Field The field in the Domino address book that contains Cisco Unified 
MeetingPlace user IDs of your users. Typically, this is the ShortName field. 
For more information on Domino authentication, see the “Enabling 
Domino Authentication” section on page 2-9.

Include Meeting Info in 
Notification

Check this option if you want meeting information (for example, date, time, 
or meeting ID) to be included in notifications received by non-Cisco 
Unified MeetingPlace for Lotus Notes users. You can customize this 
meeting information on the template files.

Verbose Logging Check this option if you want detailed entries to be logged to the Gateway 
SIM log.

Table 3-2 Notes Gateway Tab Fields (continued)

Field Description
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Step 5 For Username and Password, enter the username and password you applied for the SQL Server. 

Step 6 To submit your changes, click OK.

Step 7 Restart the Cisco Unified MeetingPlace Web Conferencing Service.

How to Configure the Calendar Entry Form by Using the 
MeetingPlace Server Agent Database

The MeetingPlace Server Agent database (MPSA.nsf) allows you to configure the Cisco Unified 
MeetingPlace for Lotus Notes calendar entry form. The Profile Document components are described in 
the following sections:

• Accessing the Administration Interface of the MeetingPlace Server Agent Database, page 3-8

• Modifying the Cisco Unified MeetingPlace Server Settings, page 3-8

• Specifying the Cisco Unified MeetingPlace Functionality Settings, page 3-9

• Customizing the Cisco Unified MeetingPlace Notification Subject, page 3-11

• Enabling Cisco Unified MeetingPlace Authentication, page 3-11

• Setting Cisco Unified MeetingPlace Scheduling Parameters, page 3-11

• Enabling Cisco Unified MeetingPlace Mailbox Automated Maintenance, page 3-12

Accessing the Administration Interface of the MeetingPlace Server Agent 
Database

To Access the Administration Interface of the MeetingPlace Server Agent Database

Step 1 From the Domino server, open the Domino Administrator and click your Domain tab (for example, 
CISCO_DOMAIN).

Step 2 From the File menu, choose Database > Open.

Step 3 From the Open Database window, choose your server.

Step 4 For Filename, enter the name of the database you want to access—in this case, MPSA.nsf—then click 
Open.

Step 5 From the left pane of the MeetingPlace Server Agent window, click Administration.

Step 6 From the right pane of the MeetingPlace Server Agent – Administration window, click Edit/Create 
Profile Document. The Cisco MeetingPlace System Profile Document appears.

Modifying the Cisco Unified MeetingPlace Server Settings
The toolbar at the top of the Cisco MeetingPlace Profile Document allows you to add new Cisco Unified 
MeetingPlace Audio Server systems and modify or delete existing ones.
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Adding a new Audio Server system places a listing for that server on the Lotus Notes Calendar Entry 
form, which allows your users to choose that server when scheduling a meeting.

• To add an Audio Server system, click Add Server and fill in the resulting fields. For field 
descriptions, see the “Adding a Cisco Unified MeetingPlace Audio Server Profile to the 
MeetingPlace Server Agent Database” section on page 2-15.

• To modify fields for your existing Audio Server system, click Modify Server.

Specifying the Cisco Unified MeetingPlace Functionality Settings
The Cisco Unified MeetingPlace Functionality Settings section allows you to control which Cisco 
Unified MeetingPlace scheduling parameters are displayed on the Lotus Notes Calendar Entry form.

Table 3-3 provides descriptions of the functionality settings. Changing any of these settings 
automatically updates the Calendar Entry form for all users associated with this mail template.

Table 3-3 Cisco Unified MeetingPlace Functionality Settings

Setting Description

Hide Meeting Password Field Prevents users from assigning a password to the meetings they 
schedule. Because a meeting ID is already associated with all 
meetings, a password is only needed if added security is desired.

Hide Billing Code Field Prevents users from entering a billing code for the meetings they 
schedule.

Uncheck this field if users need to specify billing codes on a 
per-meeting basis. Otherwise, Cisco Unified MeetingPlace uses 
the billing code listed in the profile of the scheduler for the 
meeting.

Hide # of Callers Field Prevents users from specifying the number of callers for the 
meetings they schedule.

Hide # of Video Callers Field Prevents users from specifying the number of video callers for the 
meetings they schedule.

Hide Entry Announcement Field Prevents users from changing the entry announcement options for 
the meetings they schedule. By default, Cisco Unified 
MeetingPlace automatically sets up meetings based on the 
preferences specified in the scheduler profile. Displaying this 
field in the scheduling form allows the meeting scheduler to 
change the entry announcement options on a per-meeting basis.

Hide Departure Announcement 
Field

Prevents users from changing the departure announcement 
options for the meetings they schedule. By default, Cisco Unified 
MeetingPlace automatically sets up meetings based on the 
preferences specified in the scheduler profile. Displaying this 
field on the scheduling form allows the meeting scheduler to 
change the departure announcement options on a per-meeting 
basis.

Hide URL Link Prevents the click-to-attend link from appearing in notifications 
for meetings that are scheduled by using Lotus Notes. Including 
the click-to-attend link is beneficial to non-Lotus Notes users who 
do not receive the Attend Conference option in their notifications.
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Note Flex fields are customized in MeetingTime. For information, see the applicable Configuration Guide for 
Cisco Unified MeetingPlace Audio Server, at 
http://cisco.com/en/US/products/sw/ps5664/ps5669/products_installation_and_configuration_guides_l
ist.html.

Hide Enable Recording Field Prevents users from recording the meeting.

Hide Screened Entry Field Prevents users from using the screened entry option when 
scheduling a meeting.

Hide Publicly Listed Meeting Field Prevents users from determining whether their individual 
meetings are listed on the Cisco Unified MeetingPlace Web 
Conferencing search page. Instead, this determination is based on 
the default settings in their user profile.

Make Meetings Web Only Removes the following fields from the Calendar Entry template:

• Call Me

• Phone number

• Entry announcement

• Departure announcement

• Number of locations

• Record this meeting

This is a system-wide setting. If you have multiple Cisco Unified 
MeetingPlace Audio Server systems, all Audio Server systems 
will be affected. However, this setting only applies to Cisco 
Unified MeetingPlace for Lotus Notes. It does not change the web 
interface through the click-to-attend link.

Hide Who Can Attend Field Prevents users from choosing what type of user has access to this 
meeting.

Hide Who Can Access 
MeetingNotes

Prevents users from choosing what type of user has access to 
attachments and recordings associated with this meeting.

Hide Flex Field 1 Prevents users from modifying this field.

Hide Flex Field 2 Prevents users from modifying this field.

Hide Flex Field 3 Prevents users from modifying this field.

Type of Web Conference Server Controls whether users see Cisco Unified MeetingPlace Web 
Conferencing options or IBM Lotus Sametime Online Meeting 
options when configuring the web portion of a conference (in 
either case, users can configure a Cisco Unified MeetingPlace 
audio conference).

Time Connect Button Will Appear 
(Reservationless only)

The number of minutes to display the Connect button for 
reservationless meetings.

Table 3-3 Cisco Unified MeetingPlace Functionality Settings (continued)

Setting Description
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Customizing the Cisco Unified MeetingPlace Notification Subject
The parameters in Table 3-4 allow you to customize the Subject line that appears in all meeting 
notifications.

Enabling Cisco Unified MeetingPlace Authentication
To enable the Domino authentication feature, check the Use Domino Authentication check box. For 
more information about Domino authentication, see the “Enabling Domino Authentication” section on 
page 2-9.

Setting Cisco Unified MeetingPlace Scheduling Parameters

Note The Max Adv Days to Schedule and # of Ports to Schedule settings affect scheduling only for Lotus 
Notes users. Scheduling for MeetingTime or Web Conferencing users is controlled by the scheduling 
parameters located in the MeetingTime Configure tab.

Set the parameters in Table 3-5 to specify your scheduling defaults.

Table 3-4 Cisco Unified MeetingPlace Notification Subject Parameters

Parameter Description

MeetingPlace Subject Prefix Text entered in this field appears in the beginning of the 
notification Subject line. To help users identify that they have 
been invited to a Cisco Unified MeetingPlace meeting, enter text 
such as MeetingPlace Meeting or Online Meeting in this field.

MeetingPlace Subject Postfix Text entered in this field appears at the end of the notification 
Subject line.

MeetingPlace Call Label Text entered in this field appears before the Cisco Unified 
MeetingPlace phone number in the notification Subject line. Use 
this parameter to enter a description, such as MeetingPlace Phone 
Number.

MeetingPlace Meeting ID Label Text entered in this field appears before the meeting ID in the 
notification Subject line. Use this parameter to enter a description, 
such as Meeting ID.

Table 3-5 Cisco Unified MeetingPlace Scheduling Parameters

Setting Description

Max Adv Days to Schedule Determines how far in the future a user can schedule a meeting. Users 
cannot schedule a recurring meeting chain that extends past the 
number of days specified in this field.
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Tip To keep scheduling behavior consistent, make sure that the scheduling parameters in the MeetingPlace 
Server Agent database match those in the MeetingTime Configure tab.

Enabling Cisco Unified MeetingPlace Mailbox Automated Maintenance
Meetings that are scheduled through the Cisco Unified MeetingPlace for Lotus Notes gateway are kept 
in the mail database of the Cisco Unified MeetingPlace user on the Lotus Notes server; Cisco Unified 
MeetingPlace Mailbox Automated Maintenance specifies how often the mail database is cleaned out. To 
enable this feature, complete the following procedures:

• Changing the Remove Messages Parameter, page 3-12

• Enabling the Admin CleanUp Agent, page 3-12

Changing the Remove Messages Parameter
To modify the Remove Messages parameter, change the following setting:

Enabling the Admin CleanUp Agent

To schedule the Admin CleanUp Agent through Domino Designer, complete the following procedure.

To Enable the Admin CleanUp Agent

Step 1 On the Domino server, open Notes Designer, then open the MPSA.nsf database.

Step 2 Navigate to Shared Code > Agents > Admin CleanUp.

Step 3 Double-click Admin CleanUp.

# of Ports to Schedule Determines the default number of ports that are reserved on the Cisco 
Unified MeetingPlace Audio Server system when a meeting is 
scheduled. Users can change this number on the Calendar Entry form 
during the scheduling process.

# of Video Ports to Schedule Determines the default number of video ports that are reserved on the 
Cisco Unified MeetingPlace Audio Server system when a meeting is 
scheduled. Users can change this number on the Calendar Entry form 
during the scheduling process.

Table 3-5 Cisco Unified MeetingPlace Scheduling Parameters (continued)

Setting Description

Setting Description

Remove messages older than X 
days.

Cleans out mail database messages older than X days every Y days, 
where the default value of X is 5.

The value of Y represents how often the agent runs and is specified 
when you enable the agent to clean the Lotus Notes calendar on the 
Cisco Unified MeetingPlace for Lotus Notes gateway.
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Step 4 In the Runtime section, click Schedule.

Step 5 Change the Start Running Agent At parameter to a time you wish to run this agent, then click OK.

Step 6 Close the agent, then choose Yes to save the change.

Step 7 Click the Enable button.

Step 8 Choose the server on which you wish to run this agent, then click OK.

How to Configure Cisco Unified MeetingPlace for Lotus 
Notes for Mixed Groupware Environments

If your organization has multiple mail systems, such as Microsoft Outlook and Lotus Notes, you can 
install two separate Cisco Unified MeetingPlace integrations (Cisco Unified MeetingPlace for Outlook 
and Cisco Unified MeetingPlace for Lotus Notes) on separate Cisco MCSs to support each set of users. 
Both integrations can point to the same Cisco Unified MeetingPlace Audio Server system, but must point 
to different mailboxes.

Installing each of these integrations allows users to:

• Schedule Cisco Unified MeetingPlace meetings from either their Lotus Notes or Microsoft Outlook 
client

• Receive notifications for Cisco Unified MeetingPlace meetings in their native groupware format

For information on purchasing Cisco Unified MeetingPlace for Outlook, contact your Cisco Unified 
MeetingPlace sales representative.

The following table describes the type of notification a user receives if you installed both Cisco Unified 
MeetingPlace groupware integrations. The notification received depends on the interface that was used 
to schedule the meeting.

When users receive a meeting notification in their native groupware format, they can accept the meeting 
and have it appear in their groupware calendar. Meeting notifications received in a text-only SMTP 
format do not provide this functionality.

Assigning Cisco Unified MeetingPlace Integrations to Different Mailboxes
After installing Cisco Unified MeetingPlace for Outlook and Cisco Unified MeetingPlace for Lotus 
Notes, assign each integration to a different mailbox on the Cisco Unified MeetingPlace Audio Server 
system. By default, both integrations use mailbox number 4.

Meeting Scheduled From Lotus Notes Users Receive Microsoft Outlook Users Receive

Cisco Unified MeetingPlace Web 
Conferencing or MeetingTime

Native groupware notification Native groupware notification

Lotus Notes Native groupware notification SMTP notification

Microsoft Outlook SMTP notification Native groupware notification
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To Assign Cisco Unified MeetingPlace Integrations to Different Mailboxes

Step 1 From MeetingTime, change the mailbox that Cisco Unified MeetingPlace uses to store Lotus Notes 
notifications:

a. From the MeetingTime Configure tab, choose Usage Parameters, then click Query.

b. Scroll down to Email/GW Settings and choose Lotus Notes.

c. Change the value to 2, then click OK.

d. Click Save Changes.

Step 2 Redirect Cisco Unified MeetingPlace for Lotus Notes to point to the new mailbox number:

a. From the integration server, open the MeetingPlace Gateway Configurations utility (see the “How 
to Access the Gateway System Integrity Manager Tab” section on page 3-1) and click the Notes 
Gateway tab.

b. Change MeetingPlace Mailbox to 2.

c. Click OK.

d. Restart the Cisco Unified MeetingPlace Notification Gateway (restarting the Cisco Unified 
MeetingPlace Notification Gateway automatically stops and restarts Cisco Unified MeetingPlace 
for Lotus Notes).

Step 3 Ensure that the correct type of mail system has been specified in the Cisco Unified MeetingPlace profile 
for each user.

a. From the MeetingTime Configure tab, choose User Profiles.

b. Make sure each user has the applicable e-mail system specified.

– Under Receiving Notifications, check Type of E-Mail System.

– For Lotus Notes users, choose Lotus Notes.

– For Microsoft Outlook users, choose Microsoft Exchange.

Note If you need to change the Type of E-Mail System parameter for a large group of users, import 
the proper setting by using an import file. Cisco Unified MeetingPlace allows you to import 
profile settings for users and groups. For information on importing profile settings, see the 
applicable Configuration Guide for Cisco Unified MeetingPlace Audio Server, at 
http://cisco.com/en/US/products/sw/ps5664/ps5669/products_installation_and_configuration_
guides_list.html.

How to Monitor Performance
The Windows 2003 performance monitoring tool can gather the following performance data:

• Messages deleted

• Messages purged

• Messages read

• Messages sent
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• Total messages

• Unread messages

Do the following procedure.

To Run the Windows Performance Monitoring Tool

Step 1 From the Windows Start menu, choose Run. The Run window appears.

Step 2 Enter Perfmon to open the Performance window. From the toolbar buttons at the top of the right pane, 
click Add (the button with the ‘+’ icon).

Step 3 From the Add Counters window, choose the applicable type of data. The Windows performance 
monitoring tool displays the requested data.

For more information on how to save or record performance graphs, refer to the Microsoft support 
website.
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